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Introduction

Levels Beyond introduced a Reach Engine Panel Extension for several Adobe Creative Cloud® software applications to assist with the production process,
allowing users to access the Levels Beyond repository to work with assets. As of May 2018, the following software can have the Levels Beyond extension
installed:

* Adobe Photoshop®



« Adobe lllustrator®
e Adobe InDesign®
« Adobe AfterEffects®

« Adobe Premiere Pro®

Benefits

The benefit of having the Panel Extension allows access to all your production within the Levels Beyond repository. All assets become integrated into the move-to-

production process.
For additional information: {+}https://www.reachengine.com/+

What's New?
2.15.3 Release

The 2.15.3 Release of the Panel Extension offers the following updates and fixes:

« Fixed the handling error for "invalid apiKey, readConfigFile" error for directories, port already used, reachEngineURL, and LRP (Long Running Processes).
« Fixed the defect for reading Adobe’s XML on startAME to detect previous jobs in the queue, to avoid starting and ingesting the incorrect output.

« Fixed the warning message if there was a different amount of audio channels between the proxy and the source.

Added support for multiple LRPs for LucidLink.

« Declares new origin into sidecarFile when rendering from RAME (Remote Media Encoder).

« Support Multiple AME Endpoints.

« Set config-file examples in the panels installation.

« Added a loading wheel at the render remote job button when PPRO takes too long to gather the info. This prevents multiples render actions.

« Stops waiting for the complete recoverAssets in RAME before it starts sending status.

Allows parallel downloads, render, and ingest in RAME:
¢ User can download (recover) several jobs at the same time.

« Only one render at the same time.

« User can ingest several jobs at the same time.
« Add both audioChannels and unmanaged warnings into custom workflow curtain.
« Add RAME local network support.

Identify closed projects by the moment import takes place:
1. User clicks place/import.

2. While place starts, user closes the destination project.
3. Once the asset is downloaded and import takes place, an error displays.
« Show target-project at import and when performing check-in actions.

2.14.0 Release

The 2.14.0 release of Panel Extension officially promotes it out of Beta and into General Availability. The overhauled Reach Engine Panel Extension offers:
1. Support for more Adobe applications! With one installer you'll be able to natively interact with Reach Engine in Adobe Premiere, AfterEffects, Photoshop,
lllustrator, InDesign with more coming soon!

2. Significantly improved User Interface and User Experience
a. Overhauled layout with a consistent experience with Reach Engine’s latest Ul

b. Powerful advanced search and Faceted search

c. Overhauled status activity screen with far greater detail and context for end users
3. Hundreds of stability, performance and quality of life improvements compared to older panels
a. More secure interaction with S3

b. Less configuration for Administrators
c. Significant improvements to asset import and project tracking performance and stability

2.14.0 Highlights

Automatically Restore Content
What's New?

« When a panel user is interacting with Reach Engine assets that have Content that is archived the panel will automatically prompt the user to restore the
content if desired.
¢ Restore on Import

¢ Restore on Check-Out

Why is it Valuable?

* Saves time and complexity for creatives by automating the restoration process through automated workflows
« Existing Restore workflows can be mapped to the panel configuration to immediately start importing archived content in one step
« Panel restore workflows can be customized for any specific custom behavior required

Execute Custom Workflows
What's New?

« Primary workflow menu-bar shown in panel with workflows organized by their configured group

« Use the workflow menu tool bar to select and run Reach Engine workflows. From within the panel you can execute workflows on existing assets, workflows
that runs against no assets and most importantly pass content from your Adobe Application to any Reach Engine Workflow File Input.

« All the progress of your custom workflow executions can be monitored in the Panel Status tab and of course in the Reach Engine Ul


https://www.reachengine.com/
https://www.reachengine.com/+

Why is it Valuable?
« Significantly improved flexibility between creative users and the value of custom workflow. Now that Adobe media can be contributed directly to various
workflows it becomes much easier to complete creative tasks across the content supply chain.
« Save time and stay in your creative tool by running workflows against existing assets and not switching context into another Ul

For example, select a placeholder asset in Reach Engine and ingest a sequence straight to the placeholder via workflow and exporting via Media Encoder on
the way.
e The Panel will automatically display all the required workflow form information and allow you to select your Project file or any Sequences as the input file.

« If a Sequence is selected a preset can then be selected for use by the Panel to automatically render and upload your sequence to Reach Engine and run
the workflow.

S3 Transfer Acceleration Support
What's New?
In conjunction with Reach Engine 2.14.0 and only supported on Reach Engine 2.14.0+ comes support for S3 Transfer Acceleration.

« With this functionality, creatives can save valuable time by accelerating user file uploads and user download especially over long distances.
« Once S3 Transfer Acceleration is configured in Reach Engine the Panel automatically utilizes acceleration appropriately.

2.12.0 Release

e Support for Adobe Premiere Pro
» Video Clip Assets are imported to Premiere Pro as Video Sub-Clips

* Easily render and ingest your Premiere Pro Sequences into Reach Engine
¢ Generate Metadata Schema Automatically
« Support for multiple Open Projects
Download proxies to attach in open/place/checkout
Overhauled Import and Upload for Hybrid Storage / S3
¢ Updated Local Repository Data Handling
¢ Upload Project Files via HTTP
« Standardize picklist inputs with type-ahead
Import files with Asset Name
Select Actions on Click not Hover
« Shift+select Multiple Assets
Extended Basic Search Input
+ Adobe NodelD and AssetID Tracking
Disable Default Unmanaged Asset Check-in

2.7.26 Release

« Panel Extension applies a metadata form to the assets that are about to be ingested into Reach Engine from Adobe Applications, and can then save the asset.
« The Login panel remembers the username of the last user to login.

¢ Metadata can be viewed in either Tile or List.

« Unified Collection View lets you view assets within a collection, and take action on selected asset.

e Ping Authentication

« Signing Panel Installers for MacOS Gatekeeper

¢ All .pkg installers are notarized by Apple using the Levels Beyond Apple Developer ID during the build process

« Apply a metadata form to the Assets that are about to be ingested into Reach Engine from Adobe Applications

« Updated Panel look and feel to quickly navigate and view assets in a consistent and streamlined manner, including the ability to view Metadata in Tiles.

¢ S3 download and upload credentials via API

2.7.25 Release

¢ Panel Extension checks to see if a folder exists in temp the directory on the Status tab.
« Panel Extension version displays in Preferences panel.

2.7.0 Release

Additional Action Menu Options Based On Application

Ingest a Selected Composition to Reach Engine from After Effects
* See asset icons in list view

* SAML works with One Panel

Ingest Adobe project files

Ingest multiple assets

e Use OAuth when logging in

0.5.0 Release

« |Installation Instructions

¢ Cancel Search

« Setting Initial Preferences for Source and Proxy
e Creating a collection

* Ingesting assets

* Opening assets



¢ Showing versions of assets

« Ingest asset into collection from application
* Reviewing asset status

* Updated pathmapping

Installing Reach Engine Panel Extension

The Reach Engine Panel Extension is available for both Mac and Windows users. To download the installation package, obtain the associated link from your
Levels Beyond representative.
To install the Reach Engine Panel Extension:

1. Download the .pkg or .exe from the associated link.

2. Double-click the package.
« To support the increased Security requirements of the latest MacOS versions and "Gatekeeper" all Panel installers are now Signedwith the Levels Beyond
Apple Developer ID and officially validated and Notarized by Apple Inc.

3. Click Continue on the Introduction panel.

4. Navigate to the disk where to install the package and click Continue.

5. Click Install to install the Reach Engine Panel Extension

6. If required, enter the Administrator User Name and Password and click Install Software.
7. Click Close.

Using Reach Engine Panel Extension

The Reach Engine Panel Extension from Levels Beyond lets you access assets that previously were not as easily accessible for Adobe products other than Adobe
Premiere and Adobe Prelude. Having an extension that can be loaded into other Adobe applications makes it easier to use and modify assets during the workflow
process.

Accessing the Levels Beyond Extension Panel

After the extension has been installed on for your Adobe products, the extension panel can be accessed similarly regardless of which software product you are
using. To access the extension panel:

1. In your application, navigate to Window > Extensions > Reach Engine Panel Extensions.

2. Click the the selection to display the Preferences screen.

Arrange >
Workspace

Find Extensions on Exchange...
Extensions
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Setting initial Preferences
The Preferences dialog box displays the first time accessing the Reach Engine Panel extension. All required preferences are marked with an asterisk "*".
To set up the preferences for accessing your assets:

« Enter the Reach Engine URL. This address can be an http or https URL.

« Enter the Local Repository path where you want your assets to download or be referenced. This location is also required as a reference for manual
downloads. If you're using shared storage then set this to the top level directory where your Reach Engine assets are stored. If you're working remotely then
set this to your edit RAID or other preferred location for content editing.

« Enter the Source settings. This is the Reach Engine content that will be passed to Adobe's "Source" Path
* Source

¢ Mezzanine
¢ Proxy

« Enter the Proxy setting. This is the Reach Engine content that will be passed to Adobe's "Proxy" Path. This requires "Enable Proxies" be set in the Adobe
preferences.
* Source

¢ Mezzanine
¢ Proxy

« Click Show Advanced Settings to set additional preferences for:
« Configured Remote Media Encoders

e Secondary Local Repository Path

e Log Level of detail required for error logs:
o Error

* Warning

* Info

« Verbose

e Debug
¢ Click Save.



Preferences

Ry Engine URL *

hitps://solution-dev.reachengine.com/#/login/

hitp://library.RME.AWS.com ()

htip:/flibr.CRME.LB.com (£

Notes:

« Preferences can be changed by clicking the Settings icon B

« As of Panel Release 2.12.0, the software always checks to see if a Proxy exists in the Local Repository Path before attempting to download again. If it already
exists then that file will be opened.

« As of Panel Release 2.14.0, the Source Setting and the Proxy Setting can both be "Source" for users that don't wish to pass a different file to Premiere's proxy
reference.

When there is no access to storage, the following error message displays:

Error

This directory does not exist: /Volumes/reachengine

Close

Logging in to Reach Engine Panel Extensions

The Login dialog panel displays after setting your initial preferences, and every time afterwards when accessing the extension. Your username and password are
assigned to you via Reach Engine To login:

1. Enter your user name in the User field.

2. Enter your associated password in the Password field.

3. Click LOG IN.

EXTENSIONS

system

Password *

Notes:
« The login screen varies based on your individual setup, including logo and other branding information.
e If using OAuth:
* OAuth detects a valid session



» OAuth allows two-factor authentication

« Specific code is needed for:
¢ Okta

¢ SAML

« Ping: Users are able to login and interact with Reach Engine per standard Panel supported capabilities when Reach Engine is configured for Ping
authentication

« Reach Engine will automatically log you out, and display a Keep Alive warning to continue your session.
* The time before the "Keep Alive" warning displays is dependent on the Reach Engine server logout settings.

* The Server logout setting is customizable by the client.

* Based on the server you are connecting to, the panels stores the last user login. The panel also stores a list of recently connected servers. This is unique
across the Adobe applications.

Working with assets

The Extension Panel is divided into two tabs: Dashboard and Status. When the panel is opened, all assets within your repository are accessible to work with in the
desired application. You can use the panel to search for an asset, sort assets, open the asset within the application, or view the status of an asset.

Notes:
When working with projects in Premiere Pro:

e The OnePanel is aware of the Active Premiere Project when multiple are open.
« The OnePanel tracks the Active Project when Opening or Ingest assets in and out of Projects and saves the Reach Engine Asset IDs to the correct project file.

« To decrease mistakes, when running actions in the panel the action menus will display information from the selected Project (like showing the project name
when saving) or the sequence within a project.

Viewing assets (Dashboard tab)
To view assets on the Dashboard:

1. Select 24 or 60 from the Items per page list menu in the lower right corner to select the number of asset thumbnails to view per page.

2. Scroll through the assets using the scroll bar on the side, or sort the assets using the panel's sorting functions.

3. Select whether to view assets by List or Tile.
4. If Tile view, choose the tile size with the slider. m

Sorting assets

Assets can be sorted by several options, and listed according to preferences in the Sort By selection switch. To sort the assets on the Dashboard,

1. Select Date Created, Date Updated, Name, or Relevance from the sort menu:
« Date Created and Date Updated:
« EIIEEAE sorts the dates by newest to oldest

. sorts the dates by oldest to newest

¢ Name:
« EIITEEH sorts the names from A-Z

o [EIIZMH sorts the names from Z-A

¢ Relevance:
+ EIEINH sorts the title from most to least relevant

. sorts the title from least to most relevant
2. Review the assets by using the scroll bar on the right side of the panel.

The table indicates the asset type by icon:

Review by Asset Type
You can review the asset grid and asset list by asset type:

Asset Type and Display Icon

¢ Timelines .
¢ Videos -

¢ Audio .

¢ Images -

¢ Documents .

¢ Other File Types .
¢ Collection .

* Projects -

¢ Markers .



« Timeline Clips .
e Video Clips.

Controlled Value Fields
Across One Panel, all controlled value fields (like pick lists) are updated to use type-ahead functionality reducing the time it takes to fill out information.

al

Searching for assets
To search for one or more assets with your Reach Engine repository:
1. Enter the characters (alphanumeric, or special character) in the Search Term field. The asset list updates based on the characters entered. The basic search
field is extended and sizes dynamically to increase the number of characters that are visible and decrease the cognitive load when searching.
2. (Optional) click Advanced Search.

3. In the Facets tab, optionally, select a Group from the Group drop-down, and/or select or more asset types:
¢ Audio

¢ Documents

* Images

¢ Collections

¢ Markers

e Others

e Projects

¢ Timelines

¢ Timeline Clips

* Videos

¢ Video Clips
4. (Optional) Select Date Created, Date Updated, Name, or Relevance from the Sort By drop-down list in which to search.
5. Click Sort By to view the assets by Ascending or Descending order,

6. (Optional) Click the Advanced tab.
a. Search for or select a collection from the Collection drop-down

b. Enter conditions for the search in the Field and Operator drop-downs.
c. Click +Condition to add an additional condition for your search.

7. (Optional) Click the Saved tab to run a saved search.

8. Click Search. The results display in the panel, and can be sorted as needed. Sort by
e Type
¢ Name
* Updated
e Created
* Fields in "Configure View"

9. Click X in the search field to Cancel the search.

10. Click Reset. The search results are reset.

Note: The Configure View can be set to display metadata in Tiles, and can additionally rearrange the order of the metadata via drag and drop.

PlangShoot -  Acoue - Mote =
Configure View

View Metadata

Amit Dadhwal

e ——

Working with assets

Selecting assets for use

One or more assets can be selected for use. To select one or more assets:

1. Click an asset in the panel. A check mark displays to indicate it's been selected.
Users can shift-select assets in the panel tile view and list view to import more than one.



2. Continue to select as many assets as needed.

v v

[Eal 2017-11-01 - WBITV.jpg [Ea] Screen Shot 2017-09-0...

3. Click the download button n to store the asset in your local folder if configured with cloud storage. The asset will be imported to the application and remain in
the Reach Engine repository if configured with local storage.

Creating a Collection

A Collection can be created to work with ingested assets. To create a Collection:

1. Click the Action menu u
2. Select Create Collection.
3. Type the Collection name.
4. Click Create.

Create Collection

B Roll

Note: Collections can be created by also selecting an asset to ingest and clicking the Create Collection button (+).

Ingesting assets

To ingest assets into an existing collection:
1. Select the asset or assets to ingest.
2. Click the Action menu u

3. Select Ingest Selected Asset. The Ingest Assets panel displays.
4. Select a collection from the drop-down arrow.

5. Click Ingest. The Status tab indicates the progress of the asset ingestion.

Reach Engine Panel Extension

Dashboard Status

Complete Downloading File

Complete Downloading File

Ingesting assets from application to collection

The Extensions panel allows you to ingest an asset from the application in which you're working into a collection. For example, in Photoshop, you can ingest an
asset from Photoshop into a collection. To use this feature:

1. Select a collection.

2. Click the Action menu u



3. Click Ingest asset from (application)

Ingest Selected Asset

Create Collection

Ingest Asset from Photoshop

4. Select the asset from the panel.
5. Click Ingest. The Status tab displays the progress of the ingest.

Ingest single assets with metadata
Any files used in Adobe applications can ingest into Reach Engine with metadata using forms. This allows you to ingest, with metadata, any unmanaged asset in
your project, render composition in After Effects, and the source project. To ingest and save single assets with metadata:

1. Click the Upload button to perform an ingest.
2. Choose a collection and metadata form in the right panel.
3. Click Save to save the assets.

Ingesting assets using Metadata Forms

With release 2.7.26, any files used in Adobe applications can be ingested into Reach Engine with metadata using forms. This allows you to ingest, with metadata,
any unmanaged asset in your project, composition renders in After Effects, and the source project. To ingest assets using Metadata Forms:

1. Click the Upload button in the panel to perform an ingest.
2. Use the right panel to choose a collection and metadata form to save to the assets.
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Notes:
« One Panel does not requires the Premiere Pro paths be updated to the managed Reach Engine repository paths on unmanaged ingest but rather prompts the
user.

* When desired, the panel will move the unmanaged asset into the Users Local Repository path as needed and as reported by the managed location from
Reach Engine.

Ingest Premiere Pro Sequences into Reach Engine
With Release 2.12.0, you can render and ingest Premiere Pro Sequences into Reach Engine.
1. Select the Sequence to ingest.
e
2. Select the Upload action button in the Panel.
3. Select Export Sequence and Ingest.
[P

4. Select your Output Preset, Collection, and Metadata Form in the associated dialog box.

Viewing assets in a unified collection

Assets can be viewed in a unified collection.

« If you perform an advanced search and open a collection, the associated assets display. You can then double-click the asset to review the metadata.
* The breadcrumb trail in the top left corner lets you navigate within the collection.

¢ The assets within the collection can be viewed in either List or Tile view.

e Back arrows return to previous navigation.



« Any asset selected or displayed lets you take action on them.

Assets e Search Term

£3

Advanced Search

SELECT ALL

Categories

Import Files

Any asset imported via One Panel uses the Asset name as is stored in Reach Engine rather than the default Adobe behavior of using the filename. This increases
the relevance of Reach Engine's data and decreases confusion for creatives.

When an asset is imported into Adobe from Reach Engine the Reach Engine Asset information (asset type, id, path) is added to the relevant Adobe project asset
and associated with the Adobe "NodelD" to significantly reduce duplicate file imports and decrease the amount of incorrectly identified "unmanaged assets".

Import Premiere Pro Video Clip Assets
Reach Engine Video Clip Assets import to Premiere Pro as Video Sub-Clips.

« Upon import of a Video Clip, the Parent Video asset must be downloaded and imported into Premiere as a normal video.
* Any pre-existing XMP clips that reside on the source video asset is added to the project.

T,

L

Automatically Restore Content via Import

The panel prompt a user to restore any content they've requested to import that is currently archived.

« When "Yes" is selected the panel will call the configured Reach Engine Workflow to restore the content.

* The Restore Workflow can be configured by setting local property one the Reach Engine Application server -
workflows.restoreAsset.premiere=myRestoreAssetWorkflow



L

Ingesting Projects
Adobe project files can be ingested into Reach Engine.

« Photoshop

¢ PSD

e |llustrator
o Al

¢ InDesign
e .INDD

* AfterEffects
¢ AEP

e Premiere Pro
« .PRPROJ

Note: Ingesting with After Effects

« Previously, the Panel Extension could only ingest Video files
* With release 2.7.0, users can ingest compositions into Reach Engine

Opening assets
To open an asset in the associated application (for example, opening a .jpg in Adobe Photoshop):

1. Select the asset or assets to ingest.

2. Click the Action menu u
3. Click Open Selected Asset. The Status tab displays the download progress of the asset. The asset opens when upon successful download.

Dashboard Status

Waiting Downloading File

Showing versions

The Show Versions option allows you to review the version changes of a selected asset. This option only displays when a single asset is selected. To review the
versions of an asset.

1. Select the associated asset.
2. Click the Action menu u

3. Select Show Version. The Versions panel displays with all versions of the asset, with associated data.
4. Select a version of the asset to save and click Save Current Version.



2.jpg Versions

Version # Date Modified Created By

2019-01-18,14:18:32 PM System Account

Save Current Version

Additional Action Menu ltems

The Action Menu options display based on the application in use. For example, Photoshop will have different action items from After Effects. Following is a
breakdown of actions based on application:

Photoshop
e PSD selected
e Save Project
« Hide Ingest Asset from Photoshop

« Other image types (TIFF, JPEG, PNG, PDF, etc.)
+ Hide Save Project

¢ Ingest Asset from Photoshop
lllustrator
e Al selected

* Save Project

¢ Hide Ingest Asset from Photoshop

« Other Image Types (TIFF, PDF, JPEG, etc.)
* Hide Save Project

¢ Ingest Asset from lllustrator
InDesign
¢ INDD selected
* Save Project
« Hide Ingest Asset from InDesign (You can only have INDD in InDesign)
After Effects
¢ AEP selected
* Save Project
¢ Hide Ingest Asset from After Effects

« Created Composition selected
« Hide Save Project

« Render Composition and Ingest (Update: Ingest Asset from After Effects)

¢ Other Video Types (MOV, MXF, MP4, etc)
+ Hide Save Project

* Ingest Source Asset from After Effects
+ Render Video and Ingest

Reviewing Asset Metadata

Each asset has metadata that can be reviewed. When the asset is selected, the Extensions panel applies any configuration from the local file, similar to Premiere
and Prelude. To see the asset metadata detail:

1. Double-click the asset. The asset detail screen displays.

[y——r— =

Dashboard Status.
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Metadata Tile and List view

From Configure View, users can search on and select the metadata fields to view on their assets in Tile and List view. The panels columns and tile sizes will
update accordingly after the view settings are saved. To chance views, use the selector on the left of each metadata field to change the display order.

RAGALE

Tile View

List View

Generate Metadata Schema (Premiere Pro)

Upon first launch of Premiere Pro, the Panel identifies if the metadata schema has been generated to map Reach Engine metadata to Premiere Pro metadata. If
the schema does not exist, the Panel generates it automatically. A notification displays at the bottom of the Panel to restart Premiere Pro take advantage of the
schema and metadata mapping capabilities.

=2
To manually create metadata schema

1. Click the Action menu.
2. Select Generate Metadata Schema,

T,

i

Reviewing asset status (Status tab)
To review the action status of an asset, click the Status tab. The current status of the selected asset displays with a color bar indicator:

« Completed workflows = Green (100%)
« Executing workflows = Blue (.01 - 99.99%)
« Failed workflows = Red (any %)

Note: If a temporary directory has not been selected or created on the server, an error message displays: Unable to Ingest Unmanaged Asset. Shared storage
in some client environments are latent enough, between the Reach Engine server and the Client system running the Panel, that temporary directories created by
Reach Engine wouldn't be seen for several seconds. With release 2.8.0, the panel no longer assumes the temp directory is created instantaneously. Instead the
panel waits several seconds, and retries several times, for the existence of the temp ingest directory. Should the directory still not be accessible, the panel
produces more detailed errors for improved troubleshooting. Two separate sub-error messages may display below the initial error:
¢ Unable to get unique destination directory from server.
« Panel Extension will retry the request 3 times to get the temporary directory from server.
» Each attempt is performed 500 milliseconds apart.

* Upon successful access to the temporary directory, the error message is removed.

* Unable to access into the unique destination directory. Path does not exist.
* Panel Extension will retry the request twice to create a temporary directory.

« Each attempt is performed 500 milliseconds apart.
¢ Upon successful access to the temporary directory, the error message is removed.

Unmanaged Asset Check In

When checking in a project the Save Project curtain allows the user to optionally find and add Unmanaged Assets to their project check-in.
1. Choose File > Save Project

T,
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2. Click Add Unmanaged Assets. Upon clicking the button, the Panel will identify any unmanaged assets in the project. If there are none, the user will be notified:
al
3. If there are one or more unmanaged assets, you can choose each individually, or use either Select All | Deselect All button to choose all or none of the
unmanaged assets.
al
All unmanaged assets will receive the same metadata as the project and will be added to the same Collection.
IMPORTANT NOTE: The status screen may not accurately display the ingest progress of unmanaged asset ingests.
You can still ingest unmanaged assets directly from the Adobe application at any time by selecting the asset in their project / bin and selecting Ingest Source
Asset from ... action.

al

Execute Custom Workflows

With the release of 2.14, the primary Workflow menu-bar displays in the panel, with workflows organized by their configured group. Use the workflow menu tool
bar to select and run Reach Engine workflows. From within the panel you can execute workflows on existing assets, workflows that runs against no assets, and
most importantly. pass content from your Adobe Application to any Reach Engine Workflow File Input. All the progress of your custom workflow executions can be
monitored in the Panel Status tab and in the Reach Engine Ul. This functionality significantly improves flexibility between creative users and the value of custom
workflow. Because Adobe media can be contributed directly to various workflows it becomes much easier to complete creative tasks across the content supply
chain and save time and stay in your creative tool by running workflows against existing assets and not switching context into another Ul. For example, select a
placeholder asset in Reach Engine and ingest a sequence straight to the placeholder via workflow and exporting via Media Encoder on the way. The Panel
automatically displays all the required workflow form information and allow you to select your Project file or any Sequences as the input file. If a Sequence is
selected a preset can then be selected for use by the Panel to automatically render and upload your sequence to Reach Engine and run the workflow.

To execute a custom workflow:
1. (Optional) Select an asset.

2. Select a workflow from the Workflow menu bar to execute. Workflows that run against no assets can pass content from your Adobe Application to any Reach
Engine Workflow File Input.

3. Moniter the progress of your custom workflow executions in the Panel Status tab

[, Image

For example, select a placeholder asset in Reach Engine and ingest a sequence straight to the placeholder via workflow, and exporting via Media Encoder on the
way.
« The Panel automatically displays all the required workflow form information and allows you to select your Project file, or any Sequences, as the input file.

« If a Sequence is selected a preset can then be selected for use by the Panel to automatically render and upload your sequence to Reach Engine and run the
workflow.

[, Image
« Moniter the progress of your custom workflow executions in the Panel Status tab.

[

Logging out of Reach Engine Panel Extension
To log out of the Reach Engine Panel Extension

1. Select the Settings icon [l .
2. Choose Logout.



Settings

Logou

Appendix
Upload Project Files via HTTP

Checking in Adobe Project files can be performed especially when working remotely from Reach Engine.
« Shared storage is not required to check-in Projects as of One Panel release 2.12.0.

« One Panel will always check and see if a user has access to Reach Engine's configured Project check-in path.
« If the user does have access to the check-in path, One Panel copies the project file to that location.

« If the user does not have access, One Panel uploads the project file to Reach Engine directly over HTTP.

S3 download and upload credentials via API
Release 2.7.26

One Panel's interaction with S3 has been significantly updated with the 2.7.26 release for increased security, maintainability and to be more inline with the
methods in place in the core Reach Engine Ul.

e One Panels uses signed URLs provided by the Reach Engine platform for all S3 Object interaction.

« Local properties entries for the panel's S3 connectivity should be removed so AWS credentials are not stored in plain text.

« The Panels automatically support any compatible S3 storage systems as configured in Reach Engine.

* As of Reach Engine 2.9.0, this means the panels can support buckets in multiple regions, different buckets for source or proxy or temp, and non AWS S3
compatible storage systems like ECS and SwiftStack.

Release 2.12.0

With One Panel 2.12.0 release, there are significant improvements to the file location and download logic in an environment where Reach Engine is installed "on-
premise" on a customer site with local shared-storage for the source / mezzanine content but Proxies in S3. These include:

« Improved messaging to end users when files cannot be located with additional prompts to the user to reduce repetitive tasks and increase the probability they'll
be able to access the necessary content without assistance.
« Improved handling of Local Repository data for reduced download overhead

« Improved Unmanaged Asset ingest experience with more communication to users when an updated managed path is available and improved efficiency
relinking updated paths.

Without remote storage mounted and asset proxies in S3 creatives can:

« Checkout a project

« Import assets from s3 with Proxy/Proxy preferences
e Check-in and version a project

e Check-in AND ingest unmanaged

¢ Ingest individual unmanaged asset

¢ Render and ingest a new sequence

Release 2.14.0

With One Panel 2.14.0, when AWS S3 Transfer Acceleration is configured in Reach Engine, the panel utilizes accelerated endpoints in any of its interactions for
downloads and uploads.

« With this functionality, creatives can save valuable time by accelerating user file uploads and user download especially over long distances.
« Once configured in Reach Engine the Panel automatically utilizes acceleration appropriately.

Release Details
SAML Configured Server Side

SAML works on the Reach Engine Server with the One Panel extension, similar to Prelude and Premier.

Pathmapping

The local.reach-engine.properties have updated options or pathmapping. For example the localContext.xml example can be uploaded with the following
optional beans:

## Panels
panels.pathmapping.panel_extension.mac=panel_extension_mac
panels.pathmapping.panel_extension.windows=panel_extension_windows






